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DISCLAIMER 

Use of this software is at your own risk. Neither the software developer  
nor the website operator will provide any form of guarantee. 

Damages of any kind are the sole responsibility of the end user. 
Changing ECU injection mapping or using maps not legally allowed for your country is forbidden.  

Using this software to change ECU mapping is only for track and off-road use. 
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1 Introduction 
 
TuneECU is software to program, diagnose, and test the Sagem & Keihin engine control units 
(ECU) that are used by some Aprilia, Triumph, and KTM motorcycles.  
 
The software is available for the following models with injection systems:  
  Aprilia Caponord and RST Futura  
  Triumph 3 & 4 cylinders (all EFI models)  
  Triumph twins (all EFI models)  
  KTM 690 / 990/ 1190   

Benelli  models Tornado 900  
 
The manual, software and mapping files and other usefull information are available here:  

•  http://www.box.net/shared/pusg6v7nyd  
•  http://www.tuneecu.com  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Software is FREE 
It can be given only FREELY 
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2 Installation 
 
2.1 Required configuration  
 PC (Netbook, laptop, desktop) running Windows XP, Vista, or 7; minimum screen resolution 1024x576  
 NET Frameworks 2.0 or greater  
 USB/OBD cable with FTDI chipset and the driver FTDI D2XX CDM Driver: PLEASE REFER TO TUneECU.com for the proper current driver  
                to use.  
 
2.2 Installing FrameWork 2.0 (XP only)  
NET Frameworks 2.0 http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5&DisplayLang=en  
Execute dotnetfx.exe and follow the instructions.  
 
2.3 Installing the Windows drivers  

 
Windows 7 and Vista users: MAKE SURE YOU ARE NOT connected to the internet.  
Disconnect any WIFI or Ethernet cable.  Otherwise Windows will download the latest driver  
automatically, which may not be compatible with TuneECU.  

  
 1. Plug the cable into a USB Port.  
 
 2. The PC will open the Found New Hardware Wizard to install the USB/Serial driver:  

 
 3. Choose “No, not this time” for the connection to Windows Update.  
 4. Click Next. You see this screen:  

 
 5. Under the checkbox for "Include this location in the search… ", select the path where you have downloaded and saved the drivers.  
 
 6. Click Next.  
 
 7. The USB driver is installed. Click Finish when complete.  
 
 8. Repeat the above steps for the serial driver.  

 
2.4 Installing TuneECU  
  
 1. Download TuneECU from TuneECU.com and extract the ZIP file.  
  
 2. Copy TuneECU.exe and TuneLibrary.dll  into a directory on your hard drive. For example C:\TuneECU.  
 
 3. Download the appropriate (.hex) map files for your bike from TuneECU.com.  
 
 
 

http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5&DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5&DisplayLang=en
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3 Using the Software 
 
3.1 Languages  

 

3.2 Connecting 

 

 
 
 
3.3 Manually connecting to the ECU  

 

 

3.4 Selecting a Mode  
TuneECU has 3 modes:  

 

 

4 Diagnostics 
 
                               Triumph                                                                                                                    Aprilia  

          

                                  KTM  

 

The software is available in French, English, German, Italian, 
Portuguese  and Spanish.  
The default language is set based on your windows system language. 
You can change it using the Language submenu under Options. 

Connect the USB/OBD cable to the ECU connector on the motorcycle, and the USB side to the 
computer. Turn the key to the ON position and the ignition kill switch to the RUN position, but do not 
start the engine. Start TuneECU and wait for the connection to be established. You can monitor the 
connection with the indicator at the bottom-right corner of the screen.  

• Red – not connected  • 
Orange – connecting  •
Green – connected

If the connection to the ECU is not automatic, 
select Connect from the ECU menu.  

• Map Edit: Editing and programming ECU maps  
• Diagnostics: Checking the sensors for engine management  
• Tests: Adjustment and testing of certain component of the motorcycle  

 
The mode selection is done by clicking the proper button

Benelli 
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4.1.1 Dashboard  
This screen will have a slightly different presentation between Sagem and Keihin ECUs.  
The analog gauge displays the following indicators.  
(Note, not all sensors are available on all bikes.)  
 
 

 Cooling fan On/Off 
 

 
Malfunction in the MIL system  
(EFI light on Caponord/Futura)  

 

 Fall-over sensor  
 

 Neutral (N)  
 

 
Side stand (S)  

 

 
Speed indicator  

 

 
Engaged gear number 

 

 
Engine RPM  

 

 
 

 
3 dial (Analogue/Digital)  
 

Throttle position sensor in % 
 

MAP (manifold air pressure) 
in hPa (Keihin) 

Ignition advance (Sagem) 
 

Keihin Sagem 

Engine temperature in °C. 
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4.1.2 Sensors  
The values, state, or voltage (V) of all other sensors are listed on the left side of the display. Move your mouse over the v
highlighted text will give you a definition of the value. 

Triumph 

 
 
Note:  

To hide a sensor display, click the – sign 

The display will refresh faster when fewer sensors are displayed. 
 

4.1.3 Error Codes  
 

 

Lists the error code(s) currently stored in the ECU and a short description of each. 
 

4.1.4 Status Bar  
The status bar at the bottom of the screen shows some general information. 
 

Battery Voltage  
Note: At least on Caponord/Futura, the displayed voltage is about 0.5v 
more than at the battery. This difference is also present on other 
tuning software.  

 

O2 Sensor (Closed or Open Loop)  
If the bike has an O2 Sensor, this icon will show if the system is 
operating in closed-loop or open-loop mode.  

 

TPS (Throttle Position Sensor)  
 

Connection Status (Red-Orange-Green)  
 

Name of the open map (Tune) 
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The values, state, or voltage (V) of all other sensors are listed on the left side of the display. Move your mouse over the v
highlighted text will give you a definition of the value.  

KTM Aprilia 

  

. The icon will become a +. Click the + to re-enable the sensor readings. 

The display will refresh faster when fewer sensors are displayed.  

Lists the error code(s) currently stored in the ECU and a short description of each.  

The status bar at the bottom of the screen shows some general information.  

, the displayed voltage is about 0.5v 
This difference is also present on other 

 

If the bike has an O2 Sensor, this icon will show if the system is 
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The values, state, or voltage (V) of all other sensors are listed on the left side of the display. Move your mouse over the value and a 

Benelli 

  

enable the sensor readings.  
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5 Tests & Adjustments 

5.1.1 Keihin Mode  

In this mode, only 3 small dials of the dashboard are active, providing the value of the vacuum
intake (Manifold Absolute Presure) of the corresponding cylinder (Keihin only), thus providing 
reference values for syncronising butterfly valve (throttle) opening.

 

 

*** Warning: the metal part of the candle must be in contact with the mass of the bike under threat of destruction of the coi

 

Test 

 
Turn on sequentially all lights, engine temperature chart, speed to 100km/h, 
tachometer to 7500rpm 

 

 Starts the cooling fan 
 

 Prime the fuel pump –
 

 Cycle through the idle stepper 
 

 
(Only bikes with charcoal canister) 
Activate the purge valve 

 

 Secondary air injection system 
 

  O2 sonde heater - see in Diagnostics

 Air flap (675 Daytona) located in the air intake towards the front 
 

 Exhaust valve (675 Daytona) located in the
 

 Adjust the exhaust valve 
 

/TPS 
Keihin(exept KTM) It is done in 

third dial shows the voltage (V), allowing the adjustment of the position and 
adjustment of the controller.

 

 
See the procedure in the “Resetting the Throttle Position Sensor (TPS)” section 
for Keihin. 

 

 
Excitation of the coils 
spark plugs. *** 

 

    Several triggers ----

 Test the 2nd throttle function 
 

 
Sagem: Recalibrate the throttle position sensor, Double
button 

 

 Adjust the idle fuel trim 
 

Adjust IACV (Stepper 
Motor) 

Triumph Sagem Double
It is possible to reset these two last parameters by right
during the adjustment. 

Long Term Fuel Trim Adjust the long term fuel trim (Sagem) Triumph models with O²

Adjusting the throttle cable 

The idle speed control stepper motor will be completely retracted and the throttle 
valves completely closed.
Switch the ignition switch off, WITHOUT exiting or disconnecting the software, and 
adjust the throttle cable clearance.

5.1.2 Tests Not all tests are available on all motorcycles.
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ials of the dashboard are active, providing the value of the vacuum 
intake (Manifold Absolute Presure) of the corresponding cylinder (Keihin only), thus providing  
reference values for syncronising butterfly valve (throttle) opening.  

*** Warning: the metal part of the candle must be in contact with the mass of the bike under threat of destruction of the coi

Description 

Turn on sequentially all lights, engine temperature chart, speed to 100km/h, 
tachometer to 7500rpm  

Starts the cooling fan – listen for the fan noise  

– listen for the fuel pump noise  

Cycle through the idle stepper – listen for a very quiet ticking noise  

(Only bikes with charcoal canister)  
Activate the purge valve – listen for a very quiet noise  

Secondary air injection system  

see in Diagnostics 

Air flap (675 Daytona) located in the air intake towards the front  

Exhaust valve (675 Daytona) located in the exhaust  

Adjust the exhaust valve – when you change the cable  

(exept KTM) It is done in several steps. Read the workshop manual. The 

third dial shows the voltage (V), allowing the adjustment of the position and 
djustment of the controller. 

See the procedure in the “Resetting the Throttle Position Sensor (TPS)” section 

Excitation of the coils -- hear or see if sparks will appear at the 

---- hear the function 

throttle function only  (Triumph Rocket & KTM ) 

: Recalibrate the throttle position sensor, Double-click the Reset TPS 

fuel trim (Triumph without O²-Sensor only) 

Double-click to IACV. 
It is possible to reset these two last parameters by right-clicking the arrows active 

 

Adjust the long term fuel trim (Sagem) Triumph models with O²-Sensor only 

The idle speed control stepper motor will be completely retracted and the throttle 
valves completely closed. 

ion switch off, WITHOUT exiting or disconnecting the software, and 
adjust the throttle cable clearance. 

Not all tests are available on all motorcycles. Test components of the motorcycle. 
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*** Warning: the metal part of the candle must be in contact with the mass of the bike under threat of destruction of the coil. 

Triump
h 

KTM Aprilia 
Benelli 

Keihin 

Yes 
 Only 
Tach

o 
To 

7500 
rpm 

Yes 
 Only 
Tacho 

To 5000 
rpm 

 

Yes No Yes  

Yes Yes Yes 
 

Yes Yes Yes 
 

Yes Yes Yes 
 

Yes Yes No 
 

No Yes No 
 

Yes No No 
 

Yes No No 
 

Yes No No 
 

Keihin No No 
 

Keihin No No 
 

No Yes No 
 

No Yes No 
 

Yes Yes No 
 

Sagem No Yes 
 

Sagem No Yes 
 

Sagem No Yes 

 

Sagem No Yes 

 

No Yes No 

 

 Test components of the motorcycle. 
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5.1.3 Adjustments (Keihin except KTM) 
  
Adjust the exhaust valve: Refer to the workshop manual. The third dial displays the position of the valve in % during this adjustment.  
 
Reinitialisation of the idle stepper motor: It is done in three steps. Read the workshop manual. The third dial shows the voltage (V), 
allowing the adjustment of the position and adjustment of the controller.  
 
Reset Adaption (Reset TPS): See the procedure in the “Resetting the Throttle Position Sensor (TPS)” section. 
 
KTM only 
Adjusting the throttle cable : The idle speed control stepper motor will be completely retracted and the throttle valves completely closed. Switch the 
ignition switch off, WITHOUT exiting or disconnecting the software and adjust the throttle cable clearance.  
  
5.1.4 Adjustments (Sagem) 
Reset TPS: Recalibrates the closed throttle position to a zero reading. After the reset, restart the engine and idle for at least 30 
seconds.  
 
Idle Fuel (CO): Double-click to access this adjustment. Allows adjustment of the fuel trim at idle.  
 
Long Term Fuel Trim: Double-click to adjust the parameter.  
 
Adjust Stepper Motor: Double-click to adjust the position of the idle stepper motor.  
 
It is possible to reset these two last parameters by right-clicking the arrows active during the adjustment.  
 
 

6 Maps 
(Not available in the Lite Version.)  
 
Fuel/Ignition maps of file type “.hex” are generated by reading the ECU, and available on the website (www.tuneecu.com).  
You must select a map that corresponds to your model of motorcycle and its configuration (type of exhaust for example).  
From the Display menu, choose Map Infos to see comments and the basis of the map (in parentheses).  
 

 
              

 

6.1 Selecting a Map  
 

 

 

 

 

From the File menu, select Open Map File. The map’s data appears in a grid.  
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6.2 ECU Information  

 

6.3 Map Tables  
F1  
F2 
F3 
F4 
Fuel Trim 
L1 
L2 
L3 
L4 
I1 
I2 
I3 
I4 
Ignition Trim 
 
A/F Table 
 
Idle 
 
Exhaust Valve 
 
Second Throttle 
 
F‐L Table 

 

F1 – F4: main fuel table for cylinder 1 to 4 / RPM & butterfly opening or F3-1 corresponding to the position of the 
mapping switch on the KTM 690.                     
 
  
Fuel Trim: Adjustment for the Fuel table F (in %) , or Right click on a F table if not visible. 
 
L1-4: Fuel table for the small butterfly opening / RPMs & air pressure  or L3-1 for KTM690 
 
 
 
 
I: Ignition advance table I3-1 and I LOF (Low Octane Fuel) for KTM690 
 
 
 
Correction tables "Ignition advance I (°) or right-click on a table if I is not visible, e.g. KTM 690 
 
Air/fuel                   Air/fuel ratio (AFR)  
 
 
Idle                        Engine Idle by temperature  
 
Exhaust Valve      (Daytona 675) Position of the exhaust valve / RPM.  
 
 
Butterflies             (Rocket III &amp; KTM) Position of the secondary butterflies 
  
 
Transition F – L     F to L transition and inversely / RPM and throttle opening  

 

 

6.4 Map Parameters  
Not all parameters are available on all bikes.  

 

 
Rev limit (RPM)  
Cooling fan temperature trigger  
Speedo Adjustment in % (0% = no correction) 
Speed Limit (Rocket III)  

 

 
 
NOTE: Unlike some other tuning software, TuneECU lets you only change one value for Rev Limit and Thermo Fan. That is, you 
cannot specify both ends of an on/off range for these settings. The range is fixed, but you can adjust the trigger point, changing the 
RPM or temperature at which the fixed range of values applies.  
 
 
 
 

Serial number  
Map ID  
Checksum and a counter how many times the 
ECU was reprogrammed.  
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For example:  

 
Thermo Fan = 106. The fan will come on at 106. It will shut off again at 100. (The range of six degrees cannot be changed,  
but the start point of 106 can be.)  
Similarly, the RevLimit setting has accompanying on/off parameters that cannot be changed, although the main limit setting can.  

• Rev Limit = 10,000 RPM 
• Restart Normal Fuel -50 RPM = 9950 RPM  
• Increase Fuel Cut +100 RPM = 10,100 RPM  
• Kill All Fuel +200 RPM = 10,200 RPM  

 

 
6.5 Reading Maps  
For a Keihin ECU, this operation may take 20 minutes. You must remove the headlight fuse to prevent the discharge of the 
battery. Your battery must be fully charged before doing any mapping work -- ideally connected to a battery tender.  
 
You must have a map loaded from a .hex file for TuneECU to allow you to read a map from your ECU.  
Follow the direction in “Selecting a Map”.  
KTM 690 on select maps to play (FI or EP).  
 
 
Choose Read Map from the ECU menu.  
 

 

 

This reads and displays the map in the ECU. Before doing anything else, save this map.  
 
Be sure to save the map to your hard drive.  
 
Reading time may be significantly reduced if a map with the same base is already open in the program. The base is indicated in 
parentheses.  
 
Reading progress is visible in the status bar in the bottom  

 

The operation can be canceled by clicking on the Close button. The map must be saved in order to reprogram the ECU.  
 
6.6 Changing Values and Settings in a Table (advanced use)  
It is not recommended to change tables of Fuel or Fix F & I. The map is already optimized depending on your basic configuration. 
However, if you have a dynamometer, it is always possible to adjust the values for a better performance of your particular engine. 
Other tables can be modified according to your preferences: idle, valve exhaust, and air/fuel, knowing that better power is obtained with 
an AFR value of 12.8, and lower fuel consumption achieved at 14.7.  
 
6.6.1 Editing Table Values  

 

 

 

 

Select the value by a single click. Multi select is possible.  
Change the value with the up/down button.Use the arrow keys from the keyboard, 
you can jumping from version 1.8.5 from a single selected cell in the adjacent cell.  
The change can be absolute or in % on the F & L table. F4 key allows to switch 
between modes.  Le value before modification can be display using the F6 key.  

One or Multiple cell can be copy/pasted, after selection – right click to access the copy/paste menu 

Select the first cell or multi select the value to be pasted and Right click.  
 

Note: The values that have changed in the table, are shown in white color. 
(Version 1.8.5) 
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6.6.2 Editing Map Parameters  

 

6.6.3 Comparing Maps  

 
 

6.6.4 Reprogramming the ECU  
Your battery must be fully charged before doing any mapping work -- ideally connected to a battery tender,  
better yet a second 12 volt battery from a car Your laptop must be connected to the power supply.  
 

  or  

Attention! For KTM 690: The FI and EP mapping must match on a KTM 690.   
For the KTM 690 both cards are always required (FI and EP-Map)   
FI  Throttle Power Electronic  = EPT for acronym a is EP    /  Injection Fuel Electronic  =  EFI for acronym a is 
Download progress is visible in the status bar.  
 

 

 
 

6.6.4.1 Failure to Download  
 

 

6.6.4.2 Recovering from a Download Failure  
 

 

 

 

Double-click on the parameter.  
 
Use the <Esc> key to undo the changes. Otherwise the new values are automatically saved. 

From the File menu, select Compare File. 
  
Select a different map for comparison. Pressing the <F6> key to view the values.  
 
To exit the comparison mode, select this menu again and to cancel the selection of the file. 

From the ECU menu, select Download. Or click the green Download button.  
This action prompts for confirmation. A verification of compatibility between the ECU 
and the map is done.  

At the end of the download message confirms that the operation was successful  

1. Click OK.  
2. Do not disconnect the cable.  
3. Turn off the ignition.  
4. Turn on the ignition.  
5. Wait for TuneECU to connect to the ECU.  
6. If the Download button is green, start the download again. If not, wait for the recovery option to appear.   
 

The recovery option should start automatically. If it does not, go to the ECU menu, and select 
Recovery.  
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6.6.5 Importing a PCIII or PC-V Table (PowerCommander 3 or 5) 
 

 
 

For KTM User: 
TuneECU follows the KTM convention, and commits the Trim 1 to F1 (F1 in TuneECU = rear cylinder). 
PowerCommander not follows the KTM convention, in the cyl. selective PCIII‐ or PC‐V map the table1 
is the front cylinder. 
You must change the values in the PCIII‐ or PC‐V Map before you import the cyl. selective PCIII or PC‐V map 
with TuneECU. 
 
6.6.6 Saving a Map  
 

 

6.7 Editing Tables  
 

 
 

 
 
6.8 Displaying Maps Graphically  
 

 

 

At the end of the download, a message confirms that the operation was successful.  

<Menu> File-Import PC Table (.djm table or .pvm table): 
Applies *F-corrections* from a PCIII or a PC-V table  in the "F-Trim" table. 
If available the** Ignition table** will be imported into the I Trim table. 
 
    *  includes support of "cylinder Advanced" feature, but not the "Gear  Advanced", in  
       this case you must   choose the "Gear" table to import. 
  **  Only the first Ignition table will be imported. 
 

From the File menu, select Save Map File
  
The modified map is saved as a .hex Map file. 

When working with map tables, the Edit menu contains these choices for moving blocks of table data among maps:  
 
Copy Table: Copies the table selected in the Clipboard.  
 
Export Table: Exports the selected table to a text file. 
 
Paste Table: Replaces the table selected by the one in the clipboard if the same type. 
  
Use “F Trim” for all F Tables: For all F tables, change in whole tables F or separately.  
 
Commit Trims: Corrects F fuel tables in %, and I ignition tables in °, according to the correction tables F & I, then 
puts zero values.  

To see a graphic representation of the table, select Graphic from the Display menu, or press <F5>. 
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6.8.1 Comparing Maps Graphically  
While comparing maps, press <F6> to see the comparison graph, represented with dotted lines  
Press the <F4> to switch to mono or multi curves.  

 

 
 
6.8.2 Comparing Maps Graphically for a Given RPM  
Click on any RPM to see a comparison between the two maps. Drag the mouse up and down the RPM range to see the display change 
in response.  

 

6.8.3 Comparing Maps Graphically for a Given Throttle Position  
Click on any throttle position to see a comparison between the two maps. Drag the mouse up and down the throttle range to see the 
graph change in response.  
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7 Viewing Information Logs 
 

 
 
 
 
 
 

8 Viewing History (Sagem) 
 

 
 
9 Resetting Adaption (Keihin) or Throttle Position Sensor (TPS)Sagem �
 

9.1 Keihin Triumph  
 
After each download, a  “reset Adaption”  is needed.  
 1. Turn the ignition off and back on again.  
 2. Wait 10 seconds and turn the ignition off again.  
 3. Turn the ignition on and select Reset Adaption from the ECU menu.  
 

 
Start the engine and let it idle until the TPS light in the status bar becomes green – around 10 to 15 minutes.  
 

9.2 KTM  
After downloading a FI-map, start the engine and let runnig it idle (without touching accelerator) for 15 minutes, 
then turn it off. 
After downloading a EP-map, Following a mapping download into the ECU, turn off the ignition (key) , turn on the 
ignition, slowly rotate the Throttle until full throttle then slowly close the throttle, turn off the ignition. 
 
9.3 Reset TPS Aprilia & Triumph Sagem  
 1. In the Test mode, double-click Reset TPS.  

 
 2. Turn off the ignition.  
 3. Turn on the ignition.  
 4. Start the engine and let it idle for one minute without touching the throttle.  
 

10 Erasing Error Codes 

 

Select Logs from the Display menu to see an overview 
of the dialogue between the software and the ECU. 

From the ECU menu, select History.  
You see a windows with the logs of the latest maps loaded into the ECU 

You can clear stored error codes from the ECU by choosing Erase Error Codes from the ECU menu while in 
Diagnostics or Tests modes. The issues that caused these codes must have been corrected, or the error 
code will reappear.  
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11 Options 
 

11.1 Auto-Connect  

 
 

 
11.2 Interface  
From the Options menu, select Interface to see the interface used to connect to the ECU. Connect only a single interface cable.  
 

12 Exiting the Program 
 

 

The Auto-connect option is found on the Options menu.  
If this option is checked and the cable connected, the program automatically connects to ECU. 
 By default, the auto-connect setting is enabled  

To close TuneECU, select Exit from the File menu.  
This action is not possible if a download is in progress. 
 


